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Introduction

The Business Partner Portal is accessible via UMB’s Healthcare Services website.

What’s New in Version 6.0
The Business Partner Portal User’s Guide has been updated since version 5.0 was released in March
2021. The changes are detailed below.

HSAWorks Reporting Enhancements
The HSAWorks reporting tool has been upgraded with a new interface and more dynamic reporting
options.
For more information, see “Reporting” on page 35.

Logging In for the First Time
This section deals with logging in to the system and navigating through the Multi-Factor
Authentication process.
To log on to the Business Partner Portal, you must enter a user ID and password. This prevents
others from accessing your information. The highest level of encryption available scrambles the
information being sent from your computer. This information can only be decoded by the bank’s
servers.
In addition to your username and password, you must create a unique security profile. This profile
assists UMB in recognizing you and your computer as well as verifies for you that you are on the
authentic UMB Web site.
NOTE:

Follow the procedure below the first time you log in to the Business Partner
Portal. For subsequent attempts, or if you have already set up your security
profile, skip ahead to “Logging in to the Portal” on page 6.

1. Browse to https://hsa.umb.com.
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2. Click the Account Login link at the top of the page. The Account Sign In window opens.

3. From the Sign in as list, select Brokers/Agents.
4. Enter the user name supplied to you by UMB in the User ID field and click the Log In button.
5. Enter your temporary password in the Password field and click Sign In.
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To fully protect your information while using the Business Partner Portal we require you to enroll
in additional security measures.

The first step in this process is to select and answer five security questions. If our system does
not recognize your computer when you log in, you will be asked to provide the answer to one of
the questions you establish in this step.
6. Click Next to pick your security questions.

7. Select each question by clicking the associated drop-down arrow. You must provide an answer to
all five questions. Answer fields are case-sensitive.
Business Partner Portal User’s Guide
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8. To save your questions and answers and move to the next step, click the Next button.
Next, you are asked to enter an identity question and its answer. The question should ask for
information that is known only to you. It will be used by UMB Technical Support to verify your
identity if you need to call for assistance with your account.

9. Enter a question in the Your question field.
10. Enter the answer in the Your answer field.
11. Click Next. You proceed to the Confirm page.
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12. Confirm your Security Profile. You can change the security questions or answers by clicking
Back to return to the appropriate page.
At the bottom of the page is the Yes, allow me to log in from this computer in the future option.
When you select this option, the system remembers the computer you are currently using. In the
future, you can log in using that computer without having to answer challenge questions.
13. When complete, click the Confirm button. Your Security Profile is complete.
Your temporary password now expires, and you must change it.

Business Partner Portal User’s Guide

6

Introduction

To help you protect your information, UMB has put rules in place for your passwords. Following
these rules gives you a more secure password.
•

Your password must contain at least eight characters.

•

Of those eight characters, at least three must be different.

•

Any single character can be consecutively repeated no more than four times.

•

Your password must contain at least one uppercase and at least one lowercase letter.

•

Your password must contain at least one number (digit).

14. Enter your Old Password.
15. Enter your new password in the New Password and Confirm Password fields.
16. Click Submit.
If the password does not meet a requirement, the displayed message indicates how the password
must be changed to meet the requirement.
If the password meets all requirements, the password is changed and you are passed to the HSA
Business Partner Dashboard, the system’s default landing page.

Logging in to the Portal
1. Browse to the URL https://hsa.umb.com.
2. From the Sign in as list, select Brokers/Agents.
3. Enter your User ID and click the Log In button. You may be asked to answer a security question.
If not, skip ahead to step 6.
Business Partner Portal User’s Guide
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4. Enter the answer in the Answer field. If this is a computer you use regularly, select the
Remember this computer check box.
5. Click Submit. The Sign In page opens, displaying your security image and caption.
6. Enter your password in the Password field.
7. Click the Sign In button. The Business Partner Dashboard, the system’s default landing page, is
displayed.

Logging Out
To log out of the system, click the Logout link in the top right corner of the interface.
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Interface Overview

The interface of the Business Partner Dashboard contains five tabs (circled in the image below), plus
a header that is displayed across the top of every page.

The tabs, listed below, are detailed in subsequent sections.
•

Home

•

Commission Tracker

•

Partner Resources

•

Employer Manager

•

Reporting
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The Home tab contains links to the Business Partner Dashboard and the Partner Manager. Each
of these tools provides a way for you to view and work with employer and business partner
information.

Business Partner Dashboard
The Business Partner Dashboard displays information about employer groups tied to you. In
addition, if you are an agency with multiple brokers/agents tied to your agency, you can be set up
with “agency principal” access. This access gives you the ability to view other brokers or agents
specific to your agency. If you have this access you can see the highlighted option below. Just use
the Please pick a broker to view list to select a broker or agent associated with your agency. Other
brokers or agents in the agency do not have this option and can only view their specific business.

Each employer is marked with a “traffic light” icon (circled in the image above) that reflects the
status of its HSA accounts. (See “What are Pending Enrollments?” on page 10 and “What are
Open Accounts?” on page 10 for more information.)
•

Red marks employers that have been set up and are ready to receive enrollments, but have no
accounts yet.
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•

Yellow marks employers that have pending enrollments, but no open accounts.

•

Green marks employers that have open accounts, and may have pending enrollments as well.

What are Pending Enrollments?
Pending Enrollments are individuals that have entered all the information necessary to open an HSA
but the account has not yet been accepted into our system. The most common reasons this occurs is:
•

The HDHP Effective date is set to a future date.
We will open an HSA approximately 14 days prior to the HDHP Effective date.

•

Individuals enrolling in an HSA have not clicked on the enrollment e-mail they received
after they completed the enrollment.
This e-mail verifies to UMB that we have a valid e-mail address and verifies that the individual
agrees they want an HSA.

•

CIP Error.
All Financial Institutions are required to comply with Section 326 of the USA PATRIOT Act,
which requires such institutions to collect and verify certain information about all individuals
opening an HSA. If an individual fails the CIP process, UMB performs additional background
review before releasing the enrollment. Most enrollments that require additional evaluation are
reviewed and released within 48 hours.

What are Open Accounts?
Open Accounts are individuals that have passed all requirements to qualify for an HSA and have an
active account on our system.

Navigating the Dashboard
Above the list of employers on the Business Partner Dashboard is a toolbar (illustrated below) that
enables you to navigate through the pages of employer listings.

•

Click

to jump to the first page of employer listings.

•

Click

to jump to the previous page of employer listings.

•

The
box displays the page that is currently displayed and the
total number of pages (in the example, page 2 of 5 total pages of listings).

•

Click

to jump to the next page of employer listings.

•

Click

to jump to the last page of employer listings.

•

The
list displays the number of employers displayed on each page. You can change your
selection to display more or fewer employers.
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Sorting the Employer List

The employer list table on the Business Partner Dashboard features seven columns of information.
The information in these columns can be sorted with the arrow icons on the right side of each
column.
To sort the data in ascending order (A to Z, or low to high) based on a particular column, click the
up arrow for that column.
To sort the data in descending order (Z to A, or high to low) based a particular column, click the
down arrow for that column.

Displaying Employer Information
To display information for a specific employer displayed on the dashboard, follow the steps below.
1. Click the Home tab and select Business Partner Dashboard.
2. If you are an agency principal, select a broker from the Please pick a broker to view list.
If you are an independent broker, this list is unavailable.
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3. Click the hyperlinked name of an employer (underlined and in blue). A window pops up, with
information on that employer.

4. Hide information by clicking
-or-

.

Show information by clicking

.

5. To print the information, click the Print icon

.

6. Click Close to close the window and return to the Business Partner Dashboard.
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The Partner Manager section of the Portal enables you to modify your profile information and enroll
new business partners.

Editing Your Profile
To edit your profile, follow the steps below.
1. Click the Home tab and select Edit Profile under Partner Manager.

-orClick the Edit Profile link in the top right corner of the interface.
The HSA Business Partner Profile Update page is displayed.
2. Edit the information as necessary. Fields you can edit are highlighted in yellow.
3. Click Update. A message is displayed at the top of the screen, informing you of the status of the
update.

Enrolling Additional Business Partners
To enroll a new business partner, follow the steps below.
1. Click the Home tab.
2. Under Partner Manager, click Business Partner Signup. The HSA Business Partner Signup page
(illustrated below) is displayed.

Business Partner Portal User’s Guide
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NOTE:

Depending on the commission preferences of the business partner, this form
may also prompt you to provide commission information.

3. Enter the information for the business partner.
Required fields are highlighted in yellow and marked with asterisks (*).
NOTE:

When you enter your Tax Identification Number, the system will check to
make sure it is valid. If it is not, the field will be flagged so you can correct the
problem.

4. Click Create. The system checks your address against USPS-standard addresses. The results of
that validation process is displayed in the Address Scrub dialog box.
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5. Select Use the address entered to use the address just as you entered it, with no changes.
-orSelect Use USPS recommendation to use the standard USPS address.
-orSelect Make changes and revalidate to go back to the form and enter new address information.
6. Click Continue. The information is submitted to UMB, and a confirmation page is displayed
containing important information such as your Business Partner Identification Number.

Read over the confirmation page carefully. More information regarding your enrollment will be
sent within two business days.
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Commission Tracker

The Commission Tracker tab enables you to track commissions on a quarterly basis.
To access the Commission Tracker, click the Commission Tracker tab, then click Quarterly
Commission.
The Commission Tracker page opens.

NOTE:

The Commission Tracker displays commission information only for the
current quarter. For historical data, see “Commission Summary Report” on
page 53.

Business Partner Portal User’s Guide
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Partner Resources

The Partner Resources tab contains links to helpful HSA-related online resources.

Learning Center
The Learning Center contains links to tools and information to help customers make informed
decisions about their health and about Health Savings Accounts.

Calculators
The system provides links to:
•

Online calculators to help consumers and employers determine the financial impact of their HSA
plan

•

Comparison Dashboards to help consumers compare costs between traditional and HSA-eligible
plans

•

Proposal Systems to help consumers build an HSA Plan

Using the Payroll Tax Savings Calculator
This calculator is an Excel file that enables employers to calculate savings from employees making
pre-tax contributions to their HSAs.
To use the Payroll Tax Savings Calculator, follow the steps below.
1. Click the Partner Resources tab, then click Calculators. The HSA Calculators page opens.
2. Click the Payroll Tax Savings Calculator link. You are prompted to open or save the Excel file.
3. Open the Excel file.
-or-

Business Partner Portal User’s Guide
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Save the file and then open it.

4. Follow the instructions in the file to perform the calculations.
Using the HSA Contribution Calculator
This calculator will help you calculate maximum HSA contributions based on deductible, coverage
type and other factors.
To use the HSA Contribution Calculator, follow the steps below.
1. Click the Partner Resources tab, then click Calculators. The HSA Calculators page opens.
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2. Click the HSA Contribution Calculator link. The HSA Contribution Calculator is displayed.
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Using the HSA Future Cost Calculator
This calculator will help you to calculate the projected annual cost of a traditional plan vs. an HSAeligible plan based on adjustable trends.
To use the HSA Future Cost Calculator, follow the steps below.
1. Click the Partner Resources tab, then click Calculators. The HSA Calculators page opens.
2. Click the HSA Future Cost Calculator link. The HSA Future Cost Calculator is displayed.

Using the HSA Future Balance Calculator with Beginning Balance
This calculator will help you to determine the future value of your HSA based on your forecasted
contributions, qualified medical expenses, and expected return on investment.
Business Partner Portal User’s Guide

20

Partner Resources
To use the HSA Future Balance Calculator with Beginning Balance, follow the steps below.
1. Click the Partner Resources tab, then click Calculators. The HSA Calculators page opens.
2. Click the HSA Future Balance Calculator with Beginning Balance link. The HSA Future Balance
Calculator with Beginning Balance is displayed.

Comparison Dashboards
Using the Out-of-Pocket Comparison Group
This comparison dashboard will help you compare out-of-pocket costs between a traditional plan
and an HSA-eligible plan for a group using four-tier rates.
To use the Out-of-Pocket Comparison Group, follow the steps below.
1. Click the Partner Resources tab, then click Calculators. The HSA Calculators page opens.
2. Click the Out-of-Pocket Comparison Group link. The Out-of-Pocket Comparison Group
Dashboard is displayed.
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Using the Out-of-Pocket Comparison Individual
This comparison dashboard will help you compare out-of-pocket costs between a traditional plan
and an HSA-eligible plan for an individual.
To use the Out-of-Pocket Comparison Individual dashboard, follow the steps below.
1. Click the Partner Resources tab, then click Calculators. The HSA Calculators page opens.
2. Click the Out-of-Pocket Comparison Individual link. The Out-of-Pocket Comparison Individual
Dashboard is displayed.
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Proposal Systems
Using the HSA Proposal – Monthly Premium with Renewal

This proposal system will allow you to build an HSA plan by entering monthly rates.
To use the HSA Proposal – Monthly Premium with Renewal dashboard, follow the steps below.
1. Click the Partner Resources tab, then click Calculators. The HSA Calculators page opens.
2. Click the HSA Proposal – Monthly Premium with Renewal link. The HSA Proposal – Monthly
Premium with Renewal dashboard is displayed.

Using the HSA Proposal – 4-Tier Rates with Renewal
This proposal system will allow you to build an HSA plan by entering four tier rates.
To use the HSA Proposal – 4-Tier Rates with Renewal dashboard, follow the steps below.
1. Click the Partner Resources tab, then click Calculators. The HSA Calculators page opens.
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2. Click the HSA Proposal – 4-Tier Rates with Renewal link. The HSA Proposal – 4-Tier Rates with
Renewal dashboard is displayed.

Using the HSA Proposal 4-Tier
This proposal system will allow you to build an HSA plan by entering four tier rates.
To use the HSA Proposal 4-Tier dashboard, follow the steps below.
1. Click the Partner Resources tab, then click Calculators. The HSA Calculators page opens.
2. Click the HSA Proposal 4-Tier link. The HSA Proposal 4-Tier dashboard is displayed.

Using the HSA Proposal Monthly
This proposal system will allow you to build an HSA plan by entering monthly rates.
To use the HSA Proposal Monthly dashboard, follow the steps below.
1. Click the Partner Resources tab, then click Calculators. The HSA Calculators page opens.
Business Partner Portal User’s Guide

24

Partner Resources
2. Click the HSA Proposal Monthly link. The HSA Proposal Monthly dashboard is displayed.

Useful Links
This section contains links to outside sites with more information on health and on Health Savings
Accounts.
Internal Revenue Service
•

IRS Home Page

•

Publication 502—Qualified Medical Expenses

•

HSA Basics

•

Publication 969, Health Savings Accounts and Other Tax-Favored Health Plans

•

IRS Form 8889 Health Savings Accounts (HSAs) and Instructions
•

Form 8889

•

Instructions

Health and Wellness
•

Food and Drug Administration Consumer Health Information

•

American Heart Association

•

American Lung Association

•

American Cancer Society

•

America Diabetes Association

•

National Cancer Institute

•

Nicotine Anonymous

•

WebMD

•

Mayo Clinic
Business Partner Portal User’s Guide
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Additional Links
•

AARP

•

Centers for Disease Control and Prevention

•

FamilyDoctor (straightforward general information from the American Academy of Family
Physicians)

•

Healthfinder (health library sponsored by US Department of Health and Human Services)

•

KidsHealth

•

MedlinePlus (National Library of Medicine’s comprehensive health-information portal)
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About CDHC
This page contains background information on Consumer-Directed Health Care (CDHC).

Frequently Asked Questions (FAQs)
This page contains Frequently Asked Questions on UMB’s Health Savings Account and HSA debit
cards.

Glossary
This page contains a glossary of common terms associated with HSAs and CDHC.

Documentation
This section contains links to numerous helpful promotional and administrative documents.

Marketing and Sales Tools
This page contains links to brochures and other informational documents that you can use to
educate your clients and promote UMB’s HSA offerings.
UMB Toolkits
•

Implementation Toolkit
Tools and resources for a smooth, pain-free HSA implementation

•

Launch Toolkit
Planning resources and ready-to-use templates to launch the plan during annual enrollment

•

Ongoing Toolkit
Planning resources and ready-to-use templates to educate employees and families about the highdeductible health plan and HSA, and promote benefit programs year round

•

Employer Brochure (.pdf)
Helps clients understand the benefits of a UMB Healthcare Services’ HSA

Want to brand the toolkits as your own? The Implementation Toolkit and planning resources in the
two communication toolkits are also available in “white-label” form.
Business Partner Portal User’s Guide
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Communication Resources
•

Social Media Starter Kit
Everything your clients need to know about using social media for benefits communication.

•

Benefits Article Pack
(Requires purchase from Benz Communications.) See the Launch Communication Toolkit
Planning Guide for a discount code.

Accountholder Collateral (UMB Branded)
•

HSA 101 Brochure

•

Saving and Spending Flyer

•

Eligible Medical Expenses

•

Income Tax Checklist

•

Limited Purpose FSA

Other Marketing and Sales Resources
•

Agent/Broker Partner Flyer

•

Agent/Broker Commission and Rewards

•

Acountholder Fee Schedule

NOTE:

Neither UMB Bank n.a., nor its parent, subsidiaries, or affiliates are engaged
in rendering benefit, tax or legal advice and these toolkit documents are not
intended as benefit, tax or legal advice. All mention of taxes is made in reference
to federal tax law. States can choose to follow the federal tax-treatment guidelines
for HSAs or establish their own; some states tax HSA contributions.

Documents and Forms
This page contains links to helpful UMB HSA documents.
•

Beneficiary Designation Form

•

HSA Closure Request

•

HSA or MSA Withdrawal Request

•

HSA or MSA Contribution Form

•

HSA Request for Name Change

•

Transfer to UMB from Other Trustee

•

Address Change

•

UMB Privacy Notice

•

Consolidation of UMB HSAs
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The HSA News section contains links to informational resources that can provide a good overview of
current developments and trends in the HSA world.

Healthcare Services Perspectives/Healthcare Tracker
This page contains links to newsletters and articles about current economic and healthcare trends.

UMB in the News
This page contains links to news stories about UMB Healthcare Services.

Business Partner Portal User’s Guide

28

Employer Manager

Employer Manager

The Employer Manager tab enables you to set up new employer groups. You can submit the relevant
information online, or generate a form you can manually mail or email.
The online form enables you to submit employers groups in a matter of minutes, taking the wait out
of the setup process. Once the application is completed and successfully submitted, the enrollment
link is live and the employees can begin the enrollment process.
Confirmation will be sent to both you and the Employer group once the setup is successfully
entered. Both the broker and the employer group will automatically receive an email confirmation/
welcome letter that will contain:
•

The employer’s unique enrollment link which can be provided to employees to enroll in their
HSA.

•

Details and links to request access to our Employer Portal to use our Employer Contribution tool
and view reports using HSAWorks

Setting Up an Employer Group Online
To submit employer group setup information online, follow the steps below.
1. Click the Employer Manager tab, then click Employer Group Setup. The Employer Group Setup
page (illustrated below) opens.

2. Specify how commissions will be handled for this group.
You can select Take Commission or Discount.
Business Partner Portal User’s Guide
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NOTE: When you initially signed up as a business partner with UMB and chose
“take commission” as your commission preference, you will have the options
to submit Employer groups as “take commission” ($2.50 monthly fee) or to
“discount” the monthly fee to $2.00 per month and waive your commission. If
you initially signed up with a “discount” commission preference, you will only
be able to choose the discount option in this question.
3. Specify who will pay the HSA account fees.
You can select Employee or Employer.
4. Specify whether the employer wants its employees to have ATM access to HSA funds.
You can select Yes or No.
If you select Yes, a “best practice” message displays.
5. Click Submit New Employer Group Now.
If you choose “Employer” to pay the fees in step 3, a confirmation box will appear.

Click OK to proceed and correct the selection, if necessary.
The Employer Group Setup form displays (illustrated on the next page).
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6. Fill out the form. Required fields are marked with red asterisks (*).
Note that if you answer Yes to the Accounts Payable/Invoice Contact and/or Payroll Contact
questions, additional fields display.
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7. At the bottom of the form, read the terms and select the I have read the terms and give my
consent option.
8. Click Submit. A consent box opens.

9. Click Yes.
-orClick Cancel to end the application.
The system checks your address against USPS-standard addresses. The results of that validation
process is displayed in the Address Scrub dialog box.

10. Select Use the address entered to use the address just as you entered it, with no changes.
-orBusiness Partner Portal User’s Guide
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Select Use USPS recommendation to use the standard USPS address.
-orSelect Make changes and revalidate to go back to the form and enter new address information.
11. Click Continue. The application is submitted. Processing can take a few seconds. Do not close
your session or move from this page until you see the confirmation page.

A confirmation message displays after the application has been successfully submitted.

Submitting a Printed Form
To generate an employer group setup form, follow the steps below.
1. Click the Employer Manager tab, then click Employer Group Setup. The Employer Group Setup
page (illustrated below) opens.
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2. Specify how commissions will be handled for this group.
You can select Take Commission or Discount.
NOTE:
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When you initially signed up as a business partner with UMB and chose
“take commission” as your commission preference, you will have the options
to submit Employer groups as “take commission” ($2.50 monthly fee) or to
“discount” the monthly fee to $2.00 per month and waive your commission. If
you initially signed up with a “discount” commission preference, you will only
be able to choose the discount option in this question..

3. Specify who will pay the HSA account fees.
You can select Employee or Employer.
4. Specify whether the employer wants its employees to have ATM access to HSA funds.
You can select Yes or No.
If you select Yes, a “best practice” message displays.
5. Click Create Paper Form to Submit Later. The appropriately formatted PDF form (an example of
which is illustrated below) is generated.
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6. Print and complete the form.
7. E-mail or mail it to the appropriate address.
HSABrokers@umb.com
UMB Healthcare Services
Attn: New Employer Set-up
1010 Grand; MS 1020213
Kansas City, MO 64106
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Reporting

UMB’s HSAWorks® gives you detailed reporting that helps you identify and analyze trends for your
clients. Many of the reports are perfect for your client’s auditing and compliance purposes. The
real power of this data is in discovering trends, such as overall involvement, investment averages
and employee contribution vs. distribution. Most importantly, clients have the ability to identify
their population of spenders vs. savers. The Account Summary Trends report provides a view of
the lifetime activity of the accounts which allows a better understanding of habits and any existing
trends. By better understanding these trends, your clients can react to and influence employee health
decisions leading to improved wellness and cost containment.

Accessing Employer Reports
To access HSAWorks, click the Reporting tab and select HSAWorks. You proceed to the HSAWorks
homepage (illustrated below), which opens in a new window.

The HSAWorks homepage displays a number of data points and graphs, including:
•

Counts: Open Accounts, Investment Accounts

•

Balances: Total Balance, Deposit Balance, Investment Balance

•

YTD Contributions to Last Year

•

Portfolio Balances
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•

Top 10 Empoloyers by Total Balance

•

Total Balance 5-Year Trend

•

Current Year Contribution 5-Year Trend

•

New vs Closed Accounts 5-Year Trend

On the left side of the page, you will see links to four more pages of graphs. These pages, along with
the data they present, are listed below.
•

•

Balances

•

Balance Data: Total Balance, Deposit Balance, Investment Balance, YTD Balance Change, YOY
(year-over-year) Balance Change, Average Account Balance

•

HSA Deposit Analysis

•

Portfolio Balances

•

Total Balance to Contribution Ratio

•

Deposit Balance by Rnge 5-year Trend

•

Total Balance 5-Year Trend

Contributions
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•

Contribution Data: YTD Contributions, YTD Employee Contributions, YOY Total
Contributions, Accounts with Contributions, Accounts with Employee Contributions

•

YTD Contributions to Last Year

•

Current Year Contributions 5-Year Trend

•

Percentage of Accounts with Contributions Last 13 Months

•

Prior Year Contributions 5-Year Trend

Distributions

•

Distribution Data: YTD Distribution Amount, YTD Distribution Count, YOY Distribution
Amount, YOY Distribution Count, Average Distribution Amount, Account with Distributions

•

Distribution Amount by Source 5-Year Trend
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•

Distribution Count by Source 5-Year Trend

•

Average Distribtuion Amount by Source 5-Year Trend

•

Accounts with Distributions Trend Last 13 Months

Accounts

•

Counts: Open Accounts, Investement Accounts, New Accounts YTD, Closed Accounts YTD

•

Open Accounts 5-Year Trend

•

Investment Accounts 5-Year Trend

•

Account Status 5-Year Trend

Employers
•

Top 10 Employers by Total Balance

•

Top 10 Employers by Open Accounts

•

Employers (by Agency)

Filtering HSAWorks Graph Data
You can filter the data used to create the graphs on the HSAWorks page. The view defaults to the
most recent reporting period (Current Date), all brokers, and all employers.
•

To display graphs for another reporting period, select a date from the As of Date list. The graphs
refresh to reflect data as of that chosen date.

To limit the brokers represented in the graphs, select one or more brokers from the Broker list. The
graphs refresh to reflect data for only those brokers that you chose.
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Click Reset to revert the graphs to their default view.

Working with HSAWorks Graphs
When you mouseover the graphs on the five pages within HSAWorks, a number of controls display
that enable you to work with the data represented in these graphs.

Click to drill back up to a higher level of data.
Clicking this icon enables you to drill down into the data by clicking elements of the graph. Click
again to turn off that functionality.
Click to drill down into the next level in the data.
Click to expand all data down one level in the hierarchy.
Click to enter Focus Mode, which expands the graph to full-screen. (Click Back to report to
return to the normal view of the HSAWorks homepage.)
Click to open a menu with more options.

•

Export data

opens a window that enables you to export the data in the graph
to an Excel file or a CSV (comma-separated values) text file. (See “Exporting
Graph Data” below.)

•

Show as a table

•

Spotlight

•

Sort descending

opens the graph in full screen and displays the underlying
data in a table underneath the graph.
dims the rest of the screen to highlight the graph. Click Spotlight
again to return to the normal view.
appropriately.

•

(high to low) and Sort ascending (low to high) sorts the data

enables you to sort the data in the graph by time or by the columns
represented in the data. The columns will vary depending on the graph.
Sort by
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Exporting Graph Data

To export the data from a graph displayed on the HSAWorks page, follow the steps below.
1. Mouseover the appropriate graph on the page.
2. Click More options

and select Export data. The Export Data window opens.

3. Select the data you want to export: Summarized data or Underlying data. Underlying data may
not be available, depending on your permissions.
4. Specify the File format.
•

Excel (.xlsx) files can export no more than 150,000 rows.

•

Comma-separated values (.csv) files can export no more than 30,000 row.

5. Click Export. A progress box displays during the export process.
When the exported file is complete, it is downloaded to your PC according to the download
settings you have configured in your browser.

Reports Overview
•

Account Detail List
A list of your employees with HSA accounts as of the selected date. A sample is pictured below.
This is a tabular report which includes the following columns of data on the employees:
•

Social Security Number

•

Last Name

•

First Name

•

Middle Name

•

Address

•

Address 2

•

City
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State

•

ZIP Code

•

ZIP Code 4

•

Account Status

•

Account Open Date

•

Email

•

Last 4 of Debit Card

Account Summary Report
A report summary of account balances, contribution, and distribution information for the
selected Partner and Employer. Sample pages are pictured below.
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Account Summary - Detail Data
A detailed summary of account balances, contribution, and distribution information for the
selected Partner and Employer. This is a tabular report which includes the following columns of
data:
•

TPA Name

•

Employer Name

•

Total Accounts

•

Open Accounts

•

Investment Accounts

•

Accounts Opened YTD (year-to-date)

•

Accounts Opened MTD (month-to-date)

•

Accounts Closed YTD

•

Accounts Closed MTD

•

Total Balance

•

Deposit Balance

•

Investment Balance

•

Non-Investor Accounts
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Investor Deposit Balance

•

Non-Investor Deposit Balance

•

Employee Contribution YTD Qty

•

Employee Contribution YTD Amt

•

Employer Contribution YTD Qty

•

Employer Contribution YTD Amt

•

Employee Contribution MTD Amt

•

Employer Contribution MTD Amt

•

Distribution YTD Qty

•

Distribution YTD Amt

•

Card Activity YTD Qty

•

Card Activity YTD Amt

•

Check Activity YTD Qty

•

Check Activity YTD Amt

•

Other Activity YTD Qty

•

Other Activity YTD Amt

•

Distributions MTD Qty

•

Distributions MTD Amt

•

Card Activity MTD Qty

•

Card Activity MTD Amt

•

Check Activity MTD Qty

•

Check Activity MTD Amt

•

Other Activity MTD Qty

•

Other Activity MTD Amt

•

Accts Employee Contr MTD Qty

•

Accts Employer Contr MTD Qty

•

Accts Employee Contr YTD Qty

•

PY Employee Contr MTD Amt

•

PY Employer Contr MTD Amt

•

Accts PY Employee Contr MTD Qty

•

Accts PY Employer Contr MTD Qty

•

PY Employee Contr YTD Amt

•

PY Employer Contr YTD Amt
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Accts Distribution MTD Qty

Account Summary Trends
A package of comprehensive graphs illustrating a rolling 16-month snapshot of your group’s HSA
trends. These graphs include balances, contributions, distributions, investments, and long-term
savings information so you can understand your specific trends and also compare your group’s
HSA usage with that of the overall average for the entire UMB Bank book of HSA business. This
will provide insight into how your organization’s participants use their Health Savings Accounts
and provide an idea of how you stack up against our portfolio averages.
Throughout this report set, the orange trend line represents UMB Bank’s total portfolio. In
comparison, your specific group is represented by the yellow trend line.
Each graph also has one or two key “takeaways” or important concepts that we have explained in
a narrative for each of the graphs.
•

Current Year Contribution Totals

The left axis of this graph displays total contributions by month, for both employer and
employee, and the right axis shows the per account total contribution average by month for
the group and the UMB benchmark. The key takeaway with this graph is how the group’s
average contribution per account (represented by the yellow line) compares to the all-bank
benchmark (indicated by the orange line).
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Current Year Contribution Averages

This graph displays a further breakdown of the average contributions by month for both
employer and employee amounts on the left axis, while the right axis shows the percentage of
accounts with an EE contribution.
The key aspect here, again represented by the orange and yellow lines, is “How does the
group’s percentage of accounts with employee contributions compare to the benchmark?”
This is a vital metric since it is a good barometer for employees’ engagement in their HSAs.
•

Prior Year Contribution Totals

From January 1 through April 15 of each year, account holders can make contributions to an
HSA for the prior year. This graph displays the average and total prior year contributions per
account versus the average and total prior year contributions for all of UMB. Account holders
making such contributions are typically making the most of their HSAs, taking advantage of
the tax benefits of those contributions.
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Contribution to Distribution Ratio

This graph shows a simple ratio by month of average contribution vs. distribution for the
same month. In other words, if the accounts had more money put in vs. taken out for the
month, the number will be positive. If there was more money taken out than put into the
account for the month, the number will be negative. We provide this view month-by-month
for both the employer group in dark blue and the bank average in light blue.
Employers should not focus on this metric on a month-by-month basis because there are too
many factors that can impact this measurement in any one month. Additionally, since this is
impacted by the timing of account funding and the resetting of plan year deductibles, there
may be seasonal impacts on any given months.
However, the real takeaways here are:
(1) You want to have more months in the positive than the negative, and
(2) what is the group’s overall trend?
This gives the employer some very detailed views on how the given plan dynamics are
impacting their overall trend for the entire year.
•

Deposit Account Balances
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This graph shows the total (left axis) and average (right axis) account balance by month, and
the key takeaway again is “How does the group’s average balance compare to the all-bank
average, again shown by the orange and yellow lines?” This can also be vitally important
to see what the overall balance trend is, but the next slide will dissect the balances in even
greater detail.
Deposit Account Balance Ranges

This graph provides a breakdown of all accounts by balance tier, bracketed into 10 different
ranges, and how they change over time. This is a really important view into the spectrum of
accounts, and one that would never be seen by just looking at the average balance.
This allows you a deeper look at the distribution of balance ranges, which is far more
telling than just the average balance. For instance, depending on the actual group funding
dynamics, you could actually have a situation that the average account balance is going up,
while the average employee’s account is not.
This could be caused by an employer that has a number of strong funders making max
contributions that are pulling up the average, but simultaneously the average account has
next to nothing. This disparity, or “bookending,” could easily be identified by looking at the
balance tier distribution.
This graph also helps you keep tabs on the zero- or low-balance accounts.
So the key takeaways here are:
(1) Does the group have a healthy distribution of balance ranges, and
(2) How is the group managing the low balance accounts?
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Investment Accounts

Reflects the group’s number of employees choosing to invest HSA balances in mutual funds
and compares the percentage of accounts choosing investments to the percentage for all UMB
Bank HSA Accounts. Employees that choose to invest are more likely to be engaged in their
HSA over the long-term..
•

Investment Balances

Reflects the total amount of a group’s funds that are invested in mutual funds and compares
the average investment balance per investment account to the average for all UMB Bank HSA
investment accounts.
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Distribution Transactions by Type

This slide reflects the breakdown of distribution transactions by type, with the total (left
axis) and average number (right axis) of distributions by month, along with method of
distribution. The key takeaway here, again, is “How does the group’s distribution frequency
compare to the average?” Large discrepancies may point to issues that require further
investigation.
•

Distribution Totals by Type

This graph displays the total (left) and average (right) distribution by month, along with
volume of distributed dollars, broken down by the method of distribution.
There are actually two key takeaways on this graph:
(1) the average distribution per account in yellow vs. all bank average benchmark orange line,
and
(2) the method of distribution – how the employees are taking their distributions, which is
shown by the various colors on the chart bars, showing debit card, online/ACH, and checks.
•

Distribution Averages
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This graph reflects the group’s average amount spent per transaction compared to the
benchmark average. This is a good barometer of spending.

•

Remaining Balance to Contributions

This graph provides a long-term look into account dynamics. It allows the employer to break
down the type of account utilization for their group, and see exactly how that distribution
can change over time.
This graph shows a ratio of the current account balance versus the total of all contributions
ever made into the account. For sake of ease here, it is bracketed into eight different tiers.
These tiers help identify the breakdown of the spending and saving within the group’s
accounts.
This make up of spenders versus savers is incredibly telling for the spectrum of account
holder activity within the group. More importantly, as an employer trying to drive positive
behavior change to the group, you can monitor this metric and how it changes over time.
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All UMB Remaining Balance to Contributions
This graph reflects the ratio of current total balance (deposits and investments) to the total of
all contributions ever made for all UMB Bank HSA accounts, to be used as a benchmark for
the group’s ratio breakdown in the previous chart.

Commission Summary
This report summarizes HSA broker commissions for the time period you select. A sample is
pictured below.
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Employer Contribution Report
This report enables the employer to run a list of every single contribution made into each account
for the selected time period. This can be helpful for auditing or compliance purposes. This is a
tabular report which includes the following columns of data:
•

Employer Name

•

TPA ID

•

Employer ID

•

Date Posted

•

Last Name

•

First Name

•

Middle Initial

•

Suffix

•

SSN

•

Amount

•

Description

•

Source

Enrollment/Maintenance Response Report
This is a tabular report which includes the following columns of data:
•

Effective Date

•

TPA ID

•

Employer ID

•

SSN

•

Last Name

•

First Name

•

Middle Initial

•

Response Data Code

•

Response Data Message

•

Transaction Type

•

Physical Address 1

•

Physical Address 2

•

Physical City

•

Physical State

•

Physical Zip Code

•

Mailing Address 1
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Mailing Address 2

•

Mailing City

•

Mailing State

•

Mailing Zip Code

•

Work E-mail Address

•

Home Email Address

•

Work Phone

•

Home Phone

•

Date of Birth

•

Employee ID

•

HDHP Effective Date

•

Account Open Date

Viewing Reports
To open and view a report, follow the steps below.
1. From the As of Date list, select the date of the data to be displayed in the report.
2. Click the name of a report on the Reports list. The report opens in a new tab.

Using the Reports Toolbar
When reports are displayed, a special toolbar at the of the window enables you to perform various
tasks with the report.

•

The File menu offers printing options. See “Printing Reports” below.

•

The View menu enables you to change how the report is displayed on the screen. See “Changing
Report Views” on page 54.

•

The Export menu enables you to export thre report into a number of useful formats. See
“Exporting Reports” on page 55.

•

Use the arrow buttons to navigate through multi-page reports. The page you are currently
viewing and the total page count are displayed.

•

Enter a page number and press <Enter> to go directly to that page.

•

Click

to go to the first page of the report.

•

Click

to go to the previous page of the report.

Business Partner Portal User’s Guide

54

Reporting
•

Click

to go to the next page of the report.

•

Click

to go to the last page of the report.

•

The Parameters icon opens a toolbar that enables you to filter the data displayed in the report.
See “Modifying Report Parameters” on page 55.

•

The Page Settings icon enables you to configure report page appearance. See “Changing Report
Views” on page 54.

•

The Print now icon enables you to quickly print a PDF of the report. See “Printing Reports”
below.

Printing Reports
Printing a report from the File menu creates a printable PDF version of the report that is displayed
on the screen. To do so, follow the steps below.
1. From the File menu, select Print. A Print window opens.

2. If necessary, modify any default print settings: Page Size, Height, Width, Units, and Page
Orientation.
3. Click Preview to go to the Page View version of the report.
4. Click Print. The PDF is created and the standard system Print dialog opens.
5. Click Print to send the report to the printer.
Clicking Print Now enables you to quickly print the report PDF with default settings. To do so, follow
the steps below.
1. Click Print now. The PDF is created and the standard system Print dialog opens.
2. Click Print to send the report to the printer.

Changing Report Views
The View menu gives you control over how the report is displayed in your browser window. The
interface givces you two options: Default and Page View.
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• Selecting Default from the View menu displays the report contents in the browser, similar to a
web page.
•

Selecting Page View from the View menu displays the report as it would look when printed.
•

When you display a report in Page View, the Page Settings icon is available in the toolbar.
Clicking this icon opens the Page Settings window.

Modify any default print settings: Page Size, Height, Width, Units, and Page Orientation.
Click OK.

Exporting Reports
You can export the contents of the report to multiple formats:
•

Microsoft Excel (.xlsx)

•

PDF (.pdf)

•

Accessible PDF (.pdf)

•

Comma Separated Values (.csv)

•

Microsoft PowerPoint (.pptx)

•

Microsoft Word (.docx)

•

Web Archive (.mhtml)

•

XML (.xml)

To export the report, follow the steps below.
1. Click the View menu.
2. Select the format for export. A progress box displays during the export process.
When the exported file is complete, it is downloaded to your PC according to the download
settings you have configured in your browser.

Modifying Report Parameters
Some reports allow you to filter the data displayed in the report. Those reports display the
Parameters icon in the toolbar. Clicking that icon opens the Parameters toolbar, an example of
which is pictured below.
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The data columns you can filter will vary depending on the report displayed. The reports you can
filter and the columns available for filtering are listed below.
•

•

Account Detail List
•

Last Name

•

First Name

•

Last 4 SSN (Last four digits of Social Security Number)

•

Account Status (Active, New, Inactive, Dormant, Escheatable, Pending Closure)

Commission Summary
•

•

•

As of Date

Employer Contributions Report
•

From Date

•

To Date

•

Last Name

•

First Name

Enrollment/Maintenance Response Report
•

From Date

•

To Date

•

Last Name

•

First Name

•

Error (Was an error triggered? Yes, No)

To filter report data, follow the steps below.
1. On the reports tolbar, click Parameters. The Parameters toolbar displays.
2. To filter on a specific value in a field, uncheck the Null checkbox and enter a value to filter
against.
-orSelect Null to disable the filter for that field, which will allow any value in the column, including
no value at all.
3. For date-related columns (From Date, To Date), enter a date in the format MM/DD/YYYY.
-orClick the Date icon

to select a date from a calendar.

4. For columns that enable you to select specific values (Account Status, Error), select one or more
items from the list. You can also choose Select All to choose all items in the list.
5. Click View Report to update the report based on the parameters you specified.
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Regional UMB Sales Representatives
Regional UMB Sales Representatives are available for assistance with broker/agent support, employer
support, and HDHP/HSA education. Please contact the UMB Sales Representative nearest your
location.
•

Group Sales Mailbox (All): hsasales@umb.com

•

Open/Unassigned: servicing IL, OH, MI, IN, WV, PA
Phone: 855.664.4160
Email: hsasales@umb.com

•

Brad Christensen: Located in Wisconsin, servicing WI, MN, ND, SD, MT, ID, WY, WA, OR,
CA, NV, HI, AK
Phone: 414.801.2877
Email: bradley.christensen@umb.com

•

Christian Lett: Located in Missouri, servicing MO, KS, AR, NE, IA
Phone: 816.519.9004
Email: Christian.lettt@umb.com

•

Matt Richardson: Located in Ohio, servicing CT, DC, DE, MA, MD, ME, NH, NJ, NY, RI, VT
Phone: 513.658.8139
Email: matthew.richardson@umb.com

•

Mark Robich: Located in Kentucky, servicing KY, FL, GA, AL, NC, SC, TN, VA
Phone: 513.256.3830
Email: mark.robich@umb.com

•

Chase Whitmore: Located in Texas, servicing TX, MS, LA, OK, NM, CO, UT, AZ
Phone: 501.773.6375
Email: chase.whitmore@umb.com

•

Brian Hutchin: Manager, National Healthcare Services Sales & Strategy
Phone: 816.799.1125
Email: brian.hutchin@umb.com
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UMB Healthcare Services Service Center

Support

UMB HCS Service Center representatives will assist with any day-to-day questions regarding
your needs or your client’s needs, including online enrollment, employer or employee account
management portal, payroll contributions, etc. Please contact the UMB HCS Service Center at:
Business Partner HSA Support

Employer HSA Support

(Brokers, Agents and Consultants)
Phone: 888.677.1115 (Toll Free)
Email: HSAbrokers@umb.com

Phone: 855.664.4160
Email: HSA.Administration@umb.com

UMB Service Center (Employees)
The UMB Service Center is available to answer employee questions related to their HSA accounts,
lost/stolen cards and debit card disputes. The UMB Service Center hours are Monday through Friday
from 7 a.m. to 7:30 p.m. CT and on Saturday from 8 a.m. to 5 p.m. CT.
Although the UMB Service Center is not available on Sundays and holidays, general account
questions and lost/stolen card calls will be handled 24 hours per day, seven days a week at
866.520.4HSA (4472).
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